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1 

? KEY 

SMART SETTINGS  

SMARTBOARD FUNDAMENTALS 

Gett ing Started wi th  the SMART Board 

The SMART Board is an interactive whiteboard that turns a computer and projector into a powerful tool for 
teaching, collaborating, and presenting. Use the SMART Board to interact, create, focus, capture, and 
simplify.  

STARTING THE SMART BOARD  
With the SMART Board and projector connected to the computer, turn on 
the projector and then the computer. 

The SMART Board draws power from the computer and will automatically 
become active. The SMART Board has power when the Ready Light on the 
right side of the SMART Pen Tray turns a steady green. 

SMART TOOLS MENU 
The SMART Tools menu provides quick access to the functions that help you 
operate the SMART Board more effectively. To access SMART Tools, click 
the SMART Board icon in the Windows Notification Area at the bottom right of your screen. The SMART 
Tools menu will appear. On the Mac, control-click the Board Tools icon on the doc. 

SMART SETT INGS (FORMERLY  SMART CONTROL PANEL)  
In the SMART Settings, you can configure a variety of hardware and software 
options for the SMART interactive whiteboard. We will focus on the following: 

• Orient/Align the SMART Board 
• Pen and Button Settings including Calligraphic pen  

ORIENTING THE SMART BOARD 
In order to provide an accurate and appropriate response to touch, the SMART Board will need to be 
orientated. This process allows the SMART Board Software to know exactly where the projected image 
from the computer is located on the SMART Board surface. There are many ways to orient the board.  The 
easiest way is to, 

1. Click the question (?) key, on the SMART Board Pen Tray.   
2. Click the Orient/Align button. 
3. Press your forefinger on the yellow center of each red cross in the 

order specified. 

Note: If the SMART Board or projector that is bumped or moved may need to be re-
orientated. A permanently mounted SMART board and projector require fewer 
orientations. 

MAC SMART SETTINGS  
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BASIC  OPERAT ION 
Use your finger instead of the mouse to control applications on the 
SMART Board.  

• Touch the screen with your finger and move it to control the 
cursor on the screen 

• For tasks that require double-clicking, tap the SMART Board 
twice. 

• Press the Right Mouse button on the Pen Tray, for tasks that 
require a right-mouse click. 

• To write on the SMART Board, pick up one of the pens from the Pen Tray and write on the board. 
• To erase any notes, put the pen down and pick up the eraser. Use it just like a traditional hand-held eraser 

to erase the annotations on the SMART Board. 

THE SMART BOARD PEN TRAY 
Write over any computer image by picking up one of the four colored pens from the Pen Tray. To write in 
a different color, place the pen back in its slot and select another.  

Note: The color recognition comes from the slots in the Pen Tray rather than the 
pens themselves. 

PEN AND BUTTON SETT INGS 
By default, the pens in the pen tray are black, red, green and blue. It is 
possible to change several things about their functionality and 
appearance for increased effect with certain projects or age groups.   

To customize features of the pens in the Pen Tray: 

1. From the Control Panel, select SMART Hardware Settings. 
2. Select the pen you wish to modify. 
3. Change the settings and click OK. 

You can control the following features: 

• Pen Color 
• Line/Eraser Thickness 
• Line Start and End style 
• Line Style 
• Transparency of the line 

A C T I V I T Y  1 :   

1. Launch SMART Notebook software. 
2. Write your name using a pen from the Pen Tray or your finger. 
3. Erase your name by wiping across the board with the eraser. 

KEYBOARD & RIGHT CLICK 



 

 
 

SM
AR

TB
oa

rd
 F

un
da

m
en

ta
ls

 |
 C

op
yr

ig
ht

 E
du

Te
ch

, 2
01

2 

3 

Note: The eraser will not work for objects created with line, ellipse or rectangle tools.  These objects must be selected and 
deleted.  

SMART Board Tools  

The SMART Notebook toolbar is divided into groups of buttons to make Notebook easier to work with. 
The groups are Actions, Tools and Properties.  

• Actions include common operations like page navigation, add and delete a page, and save or open a file. 
However, actions also include things like inserting a table, screen capture, deleting objects, etc…. 

• Tools are for creating shapes, drawing lines, pens for freehand writing and drawing, adding text, etc…. 
One of the most important tools is the black Select arrow. Anytime you want to work with an object 
on a page, first click the Select arrow and then select (click on) the object you want to work with. 

• Properties allow you to change the look of objects that you create with the tools. Clicking a tool 
automatically shows the corresponding property options for that tool. Additional property options may 
be available by clicking the properties tab. 

By default, the toolbar appears at the top of the Notebook page. When you are working with young 
students, it may be more convenient to move the toolbar to the bottom of the page. To do this, click the 
double-ended, vertical arrow on the far right of the toolbar. 

Scrolling over a button on the toolbar gives a brief description of what the button does. 

 

SOME TOOLBAR BUTTONS EXPLA INED 

• To paste an item, select the Paste icon. 

• Undo or redo the last actions you performed, select the Undo  or Redo 

icons. 

• To delete an item, select it, and click the Delete icon. 

• The Screen Shade allows gradual reveal of information to create suspense 
or hide text and graphics by dragging the shade left or right, up or down. 

• There are several View Screen options that include: 
o Select Full Screen option, a Full Screen toolbar will appear. To exit 

the Full Screen mode, click on the Red X in the upper right corner of 
the toolbar.  

o Transparent Background, using Transparent Background, you can view 
the desktop and windows behind the SMART Notebook window and 
continue to interact with the open, transparent file. You can draw on a 

VIEW SCREEN OPTIONS 
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transparent page and save your notes in the file. You can also display measurement tools, take 
screen captures, etc…. If an area of the screen does not include any SMART Notebook objects, 
you can interact with the desktop and applications behind the SMART Notebook window. 

o Use the Dual Page Display option to display two Notebook pages at a time from the 
same notebook. This is a great way to compare and contrast the content on two pages. 

o Entire Page: Select to show entire page in the display. 
o Page Width: Select Page Width to set the page's width to the same width as the display. 

• Screen Capture, the Screen Capture tool allows you to take a snapshot of what is on the computer 
screen and save it to a Notebook page. We will explore the screen capture feature later in this workshop. 

• The Document Camera requires a document camera. 
• Use the Internet Browser button to insert a browser window on a page. Great for showing web videos. 

• Use the Select tool  to select objects for editing, moving or copying. 
• The Pen tool offers seven different pen types. Of special note are: 

o The Shape Recognition Pen tool allows you to draw perfect 
circles, squares, triangles as well as other shapes. Draw a shape to 
understand how it works.   

o The Magic Pen tool is actually three tools in one. 
! Draw a straight or curved line and the ink from the Magic Pen 

will slowly disappear. All pens now offer  
! Draw a circle to create a spotlight. 
! Draw a rectangle to create a magnifier 

• To move the spotlight or magnifier, click and drag outside of the spotlight or magnifier. 
• Click and drag in the center of the spotlight or the magnifier window to increase its 

circumference or perimeter. 
o The Creative Pen has several default image stamps. You can make a custom stamp by clicking 

the properties tab then choosing Line Style and selecting "Use a custom stamp image". 
o Apply the fade effect to the Pen tool by clicking the pen then clicking the properties tab, 

selecting Fill Effects and checking the box next to Enable ink to fade after you write it, be sure to set 
the Fade time. 

• Use the Eraser  tool to erase items created by the pens. Some eraser options include: 
o Use the physical whiteboard eraser to erase items.  
o Click the eraser tool on the toolbar. Note the size options available for the eraser. 
o Draw a circle around several objects with the eraser and then tap in middle of the circle. 

• The Line tool contains a variety of line options. Choose a line and then click and drag on the SMART 
Board to draw it. 

• The Shapes  and Regular Polygons tools contain a variety of shapes. Choose a shape and then 
click and drag on the SMART Board to draw it. 

• The Fill tool allows you to "fill" an outlined shape with a Solid fill, Gradient fill, Patterned 
fill or Image fill. To fill an area: 

a. Select the Fill tool 
b. Choose the desired Fill property. 

PEN TYPES  
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ON-SCREEN KEYBOARD BUTTON  

c. Click in the center of the area you wish to fill. 

• Use the Text tool to create a text box. Enter text from the 
computer keyboard or click the keyboard button on the tray of the 
SMART Board to load the on-screen keyboard.   

Using the on-screen Ke y b o a r d  

You have the option to switch between the Classic, Number Pad, 
Write, Shortcut and Simple or Simple Caps view.  
• The Settings button allows you to select Sound, Number of 

keys, Conversion time, Location and Keyboard 
transparency. 

• Touch the desired location for your text and begin typing. 

To edit text after closing the Fon t  toolbar, 

1. Click on the Select tool. 
2. Double click on the desired text. The Font toolbar will open to 

allow for editing on the selected text. 
3. Click anywhere outside of the textbox to close the Font toolbar. 

Create and store Custom fonts by selecting the T ex t  tool and then 
clicking on the P r o p e r t i e s  menu. To do so, 

1. Select the font you wish to change from the Text drop box. 
2.  Open the Properties menu. 
3. Select the Line Style tab.  
4. Choose the desired Color. 
5. Select the Fill Effects tab to modify the font's Transparency. 
6. Select the Text Style tab to modify the Font, Size and Font 

Style. 
7. Select the Save Tool Properties button. 

A C T I V I T Y  2 :   

Add the following tools to the toolbar using the Customize the toolbar button: 

• Clear Ink: Deletes any annotations from a page. 
• Clear Page: Deletes all objects from a page. 
• Reset Page: Reset page to its starting point. 
• Transparent Background: view the desktop and windows behind the SMART Notebook window 

and continue to interact with the open, transparent file 
• Internet Browser: Browse the Internet without leaving your SMART Notebook file. 

Take some time to work with the tools, especially the creativity tools. Make sure to include some 
formatting as well as adding additional pages to the project. 
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Working wi th  Objects  

SELECT ING OBJECTS 

To select an object, click the S e l e c t  tool. 

1. Tap or click on the object and a selection box with handlebars appears around 
it. 

2. To select multiple objects, touch the board with your finger and drag it 
across the objects you want to select. 

3. Select all objects by "right clicking" on the page and choosing Select All. 

OBJECT 'S  DROPDOWN MENU 

• Clone-One step copy and paste 
• Cut, Copy, Paste and Delete behave as they do in 

other applications 
• Locking-Locks objects in place so they can’t be moved 
• Grouping-Merge objects to form a single object. 

Group and ungroup using shake gestures. 
• Flip-Object s can be flipped both horizontally and 

vertically 
• Order-Allows one object to be moved behind another 
• Infinite Cloner-Set Infinite Cloner and create 

multiple copies of an object by clicking on an object and 
dragging to another part of the page. 

• Link-Allows an object to become a link to a web page, 
another page in Notebook, a file on the computer or an 
attachment 

• Sound-Allows sound to be added to an object 
• Properties-Allows the object to be formatted 
• Note: some options are only usable if you have purchased the Math tools. 

FORMATT ING OBJECTS 
Select an Object and it's Properties options appear on the toolbar. Additional options may be available by 
clicking the property tab. Also, click the objects drop-down menu for editing, format and draw options. 
The following are general rules and may not apply in all cases. 

• Drawn Object- You can usually format outline color, line properties and transparency 
• Gallery Object- You can only format outline color and transparency 
• Text Object- You can usually format text color, transparency, font and style  

Note: The formatting tools on the toolbar may also be used. 
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HANDWRIT ING RECOGNIT ION 
SMART Notebook can recognize hand written text and convert it to a typewritten font. 

To convert the drawn object to text:  

1. Select it by dragging the Select tool across the entire handwritten text area. 
2. Choose the desired Recognize option from the pull-down menu. 

 

SAVE A  NOTEBOOK 
The first time you save a Notebook file you are prompted to Save As. A saved notebook file is given the 
file extension .notebook. You can also open and save files by using the File menu. You can open a 
previously saved Notebook file by selecting the Open File icon. There are several options for saving a 
Notebook session. 

S a v e  a s  a  N o t e b o o k  F i l e  

1. Go to File on the Main Menu  
2. Select either Save or Save As 

S h a r e  o n  S M A R T  E x c h a n g e  

This option allows you to log into your SMART Exchange account and submit your notebook as a SMART 
Exchange resource for others to use. The process includes filling out a form on the type of resource it is and 
agreeing to the terms of the site, which include copyright compliance on the contents of your Notebook. 

S a v e  a s  a  G a l l e r y  I t e m  

To use your notebook page as an as a template or Gallery item, 

1. Go to File on the Main Menu  
2. Select Save Page as Gallery Item 
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EXPORT A  NOTEBOOK 
Export notebooks in several different file formats that include: 

E x p o r t  a s  W e b  P a g e  

Use this command to generate a series of HTML files for viewing in a Web browser. A separate HTML 
page is created for each page of the Notebook file. 

1. Go to File on the Main Menu 
2. Choose Export 
3. Select Web Page 

E x p o r t  a s  I m a g e  F i l e  

Saving the Notebook file as an image will allow others to view the file content without installing Notebook 
Software. There are many different formats to choose from: JPEG, PNG, GIF or BMP.   

1. Go to File on the Main Menu 
2. Choose Export 
3. Select Image Files 

E x p o r t  a s  P D F  

Use this command to generate a file that can be read using Acrobat Reader software, available free of charge 
from Adobe’s Web site at www.adobe.com/products/acrobat .   

1. Go to File on the Main Menu 
2. Choose Export 
3. Select PDF 

E x p o r t  a s  C F F  

CFF (InteractiveWhiteboard Common File Format) file that can be used by other whiteboard programs. 

1. Go to File on the Main Menu 
2. Choose Export 
3. Select CFF 

E x p o r t  a s  P o w e r P o i n t  

Use this command to generate a file that can be used as a PowerPoint slideshow. 

1. Go to File on the Main Menu 
2. Choose Export 
3. Select PowerPoint 
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P r i n t i n g  

You can also print a copy of your Notebook session. 

1. Go to File on the Main Menu.  
2. Select Print.  

SCREEN CAPTURE 
The Screen Capture tool allows you to "take a picture" and save it to a Notebook page. When you select 
this tool, a Screen Capture toolbar appears. 

Capture options 
Area 
Capture 

Full Screen 
Capture 

Window 
Capture 

Freehand 
Capture 

    
Example: Capture an area 

1. Click the Area Capture tool 
2. Then click and drag to outline the area to capture.  
3. Switch to the SMART Board Notebook software to view and/or 

edit. 

A C T I V I T Y  3 :   

1. Open a Web browser. 
2. In the address bar, type:  http://chiron.valdosta.edu/mawhatley/writing.htm 
3. Click the link:  Poor Writing Examples. 
4. Pick up a pen. Make sure you have the screen capture toolbar open. Alternately, add the area 

capture icon onto the floating toolbar when you customize it. 
5. Click the Area button 
6. Select one of the sentences in the list by clicking and dragging a box around it. Once the mouse is 

released, the captured text will appear on a new Notebook page. 
7. Select two more sentences by repeating steps 5 and 6. 

Go back to the SMART Notebook and make the corrections to the sentences. 

SCREEN CAPTURE TOOLBAR 



 

 

SM
AR

TB
oa

rd
 F

un
da

m
en

ta
ls

 |
 C

op
yr

ig
ht

 E
du

Te
ch

, 2
01

2 
 

10 

CUSTOMIZING THE TOOLBAR 
Click Customize the toolbar or right-click on an open area of the toolbar to add new tools.  

1. Drag items from the Customize Toolbar window onto the Notebook Toolbar to add them. 
2. Drag items off the Notebook Toolbar to remove them. 
3. Click on the Restore Defaults button to revert to the original toolbar. 

 

Creat ing L inks 

Hyperlinks to Webpages, other pages in a Notebook session, documents or files are easy to create. 

L INKING PAGES &  F ILES 
1. Select the text or object you wish to link. 
2. Click the drop down arrow and select Link. 
3. Choose either a Web Page, Page in this File, File on this Computer. The linked file will 

appear in Current Attachments. 
4. Depending on which option you chose above, you will need to enter a Web address, select a 

Notebook page or browse for a file on your computer. 
5. Choose to Launch by clicking either a Corner icon or Object. 
6. Click OK. 
7. To remove a link, follow steps 1-2 and click Remove Link. 

L INKING FLASH & MOVIE  F ILES 
1. Select the text or object you wish to link. 

CUSTOMIZE TOOLBAR WINDOW 

CUSTOMIZE 
TOOLBAR  
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2. Go to Insert on the Menu. 
3. Choose either Flash File (.swf) or Flash Video Fil (.flv). 
4. Locate the file on your computer. 
5. Click Open. 

Note:  You must first have the flash or movie file downloaded and available in a folder on your computer. 

SHOWING L INKS 
The S h o w  A l l  L i n k s  feature briefly highlights all objects linked to a website, file, another Notebook 
page, or a sound with an animated box. To show the links in your current Notebook session, 

1. Click on View on the menu bar. 
2. Click on Show All Links to show links at this time. 
3. Click on Show All Links When Page Opens to show links each time a page opene during the 

current session. 

Creat ing and Using Tables  

Create a custom table to insert data, objects, and graphics into the cells. You can apply shading to any cell 
within the table, allowing for even more interactive lessons.   

INSERT ING A  TABLE   
To insert a table: 

1. Click the Table tool. A table grid will appear. 
2. Drag across the table grid to select the amount of cells desired. The table will now appear in the 

center of your Notebook page. 
3. To move the table to a different location, select it and click and drag on the gray square in the 

upper left of the table. 

ADDING IMAGES IN  TABLE:  
1. Select an image from the gallery. 
2. Drag the image into the desired cell.  (The image will automatically resize to fit the cell.)  

SPLITT ING CELLS:  
1. Click a cell until it’s shaded. 
2. Right-click on the cell again. 
3. Select Split and then one of the six splitting options. 

DELET ING CELLS 
To delete cells in your table, 

1. Click and drag across the desired cell(s). 
2. Once the desired area is highlighted, right-click it. 
3. Select Delete Cells, or if you are deleting a column or a row select that option. 
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SHADING CELLS 
1. Select the desired cell(s). 
2. Once the desired area is highlighted, right click it. 
3. Select Add Cell Shade.  (To "open" the shade, click on the cell.) 

Other  Notebook Features 

PAGE SORTER 
Page Sorter is a view option which allows you to easily see and navigate between pages contained in the 
current Notebook session. Once a page has been selected, you can access a pull-down 
menu to create, rename or delete pages. Within Page Sorter you can organize your 
content into groups.   

GALLERY 
The Gallery contains a variety of objects that can be used in Notebook including 
some animated Flash objects. There is a search field for finding a specific gallery item 
as well as tree style navigation. The gallery can be updated from Smart Tech’s 
website by clicking on the update button. 

ATTACHMENTS 
This feature allows you to add and manage attachments. You can add web links, pdf 
files, flash files, and all types of Microsoft office files.  This allows easy access to 
resources that relate to the current Notebook session. When you insert a pdf file it 
creates an image of the first page of the file on your notebook. 

PROPERTIES 
The Properties tab shows the full range of options for a tool. To use this tab, select an 
object or click on a blank area of the page, THEN click the Properties TO see 
Property options for whatever you clicked.  

ACTIV ITY  BUILDER 
Create interactive lesson activities easily by using the Activity Builder. To start, click the Add-ons tab, and 
then click the Activity Builder thumbnail and follow the instructions.  

TABS  
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Float ing Tools  

The floating toolbar is a portable, customizable palette of tools that float over any application used 
with your SMART Board. With the Floating Tools open, you have access to the same configurable 
pens and erasers as the Pen Tray. To move the Floating Toolbar, click on the handle "dots". 

1. By default Floating Tools appear when you open Notebook. 
2. Select the desired tool from the palette and use it over any open application. 
3. Add tools to or remove tools from the current toolbar by selecting the Customize 

Floating Tools icon. 
4. To return the Floating Tools to its default state, click on the Restore Default Toolbar 

button at the bottom. 
5. To customize the pen properties, choose the Properties icon on the right of selected pen. 

To hide the Floating Tools completely:  

1. Click on the SMART Board icon in the Windows Notification. On Mac, control-click the 
Board Tools icon on the doc. 

2. Select Hide Floating Tools. 

A C T I V I T Y  4 :   

Add the following icons to the Floating Tools palette: 

• Spotlight 
• Screen Shade 
• Magnifier 
• Pointer 

Take some time to use Floating Tools over several different applications. 

Presentat ion Tools  

SPOTL IGHT 
Use the Spotlight to draw attention to a particular area of the screen, just as a spotlight draws attention to 
a portion of a stage. Move the spotlight to different areas of the screen. 

• To move the Spotlight, click an area of the screen outside the spotlight and drag the spotlight. 
• To resize the Spotlight, click and drag on the border. 
• To change the transparency of the spotlight, click on the drop box and select the appropriate amount of 

transparency.  
• To close the Spotlight, click on the spotlight icon to turn off. 

FLOATING 
TOOLBAR  

Handle 
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SCREEN SHADE 
The Screen Shade allows the user to cover information and reveal it slowly. To turn on the Screen Shade, 
click on the Screen Shade icon. Initially, the screen covers the entire screen and includes handles on all 
sides. Click on a handle and drag from the edge to reveal. To turn off the Screen Shade, click the close 
button or click on the Screen Shade icon. 

MAGNIF IER 
Use the Magnifier to enlarge an area of the screen. Click on the Magnifier icon and two boxes appear 
on the screen, a small one and a large one. Drag the smaller box over an area of the screen for that area to 
appear enlarged in the larger box. To close the Magnifier, click the Close button in the upper left corner. 

POINTER 
The Pointer is a useful tool that displays a large arrow on the screen to help the presenter in drawing 
attention to the screen. Drag the arrow at the back half to move the arrow. Drag on the arrowhead to 
change the direction or rotate. To put the Pointer away, double click on the arrow. 

SMART Recorder  

The SMART Recorder allows you to record and play back an entire lesson.  Create a video of every action 
on the SMART Board with the SMART Recorder. Attach a microphone and record audio with the video. 
Use SMART Video Player on the PC or QuickTime on the Mac to view the recorded movies. 

1. Click on the SMART Board icon in the Windows Notification Window or on a Mac, control-click 
the Board Tools icon on the doc. 

2. Select Recorder to open the SMART Recorder controls. 
3. Click the red Record button in the SMART Recorder toolbar to 

record the whole screen or from the pull-down menu next to 
the Record button, select Record Area. 

4. To end the recording, click the Stop button. The Save As 
dialog box will appear.  

5. Select a destination to save the file in the Where drop down list. 
6. Name the file in the Save As box. 
7. Click Save.  
8. Click OK.  

SMART V ideo P layer  

You can view movies on your SMART Board with the SMART Video Player on a PC or (use QuickTime on 
a Mac). With the SMART Video Player you can write or draw over video during a presentation and capture 
a single video frame into Notebook software. Use SMART Video Player to play video files located on your 
computer or view content from a camera, VCR, CD-ROM or DVD. Smart Video Player is only for the PC. 
Video annotation is not available on the Mac. 

  

SMART RECORDER CONTROLS  
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To access the SMART video player (PC only): 

1. Click on the SMART Board icon in the Windows Notification Area in the lower right (near the 
time). 

2. Select Video Player. (A SMART Video Player window will open.) 
3. Click on File and select Open to access a video on your computer.  (You can also access video 

footage directly from your camera by selecting Hardware.) 
4. Browse for the desired video. 
5. Click Open. 
6. Click the Play button. 
7. Lift a pen from the Pen Tray to stop the video. 
8. Adjust settings as desired. 

WRIT ING TEXT  ON V IDEO OR OTHER APPL ICAT IONS 
You can write notes on your movie using any of the pens in your floating tool bar or by simply writing on 
the movie with a pen from the Pen Tray. You can right click after you have written and select Clear Ink, 
or you can select Save Ink and a screen shot of your writing will appear in Notebook. You can also select 
the Ink Aware Screen shot icon (2) at the top right hand corner of the page, and your notes will be saved as 
a screen shot on Notebook. To close ink aware, click the red X (3). 

A C T I V I T Y  5 :   

Take some time to create a movie using SMART Recorder. Save the file and play it using SMART Video 
Player, Windows Media Player, and or QuickTime Player.  

Contro l l ing  a  PowerPoint  Presentat ion 

Control a PowerPoint presentation on the SMART Board using a three-button control bar.  

1. Open the PowerPoint presentation and click on the Slide Show icon. 
2. Move from slide to slide using the left and right arrows located in the lower left of the screen. 
3. Hover the mouse in the lower left hand corner to bring up an options menu or pick up a pen from 

the Pen Tray and write over top of the slide.  

Note: If you return the pen to the Pen Tray without saving the note, the note will disappear the next time the screen is 
touched. 

SMART BOARD WRIT ING T IPS:  

• Write in big letters and not small ones. 
• Write in a straight line. 
• Write left to right, not vertically or right to left. 
• Constantly click the interactive screen to ensure contact points 
• Remember that the pen tray color is the line color unless customized to another color.  
• Put pen back in the tray when finished. Until put back, the computer will interpret screen touches as pen 

strokes. 
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APPENDIX A  

Working wi th  SMART Response 

Having a SMART Response system connected to your SMART Board allows you to tally student responses, 
record attendance, or post test results. Each response is recorded and then can easily be displayed on your 
SMART Board along with classroom statistics to individual responses.   

To include a SMART Response question set to your lesson, 

1. Go to Insert on the Menu. 
2. Scroll down and select SMART Response Title Page. 
3.  Go back to Insert and select Insert SMART Response question.  You will have the option of 

entering Yes or No, Multiple Choice, Number, Fraction, Decimal, True or False, or Multiple 
Answer questions. 

 

A C T I V I T Y  6 :  

1. Go to Insert>SMART Response Title 
Page 

2. Type in a Title and Type. 
3. Click Add. 
4. Go to Insert>SMART Response Question 
5. Select the Yes or No question type. 
6. Click Next. 
7. Type:  Was George Washington the first 

President of the United States? 
8. Click Next. 
9. Select the correct answer as Yes. 
10. Select the number of Points to be 5 and click Finish. 

Note:  Repeat steps 1-10 in order to practice with other Question type selections.  

Yes or No Multiple 
Choice 

Number, 
Fraction, 
Decimal 

True or 
False 

Multiple 
Answer 


